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Overview

Topology

The following diagram gives an overview of the SAcM Password Synchronizer:

(1) User changes (3) Password change
password with the analyzed by the PwdSync
console program Controller using the Rules

v v

Database definitions

3
workstation

(2) Username
and password
or sent to controller

Domain Controller

Windows UNIX OpenVMS

(1) Password change

detected by interceptor Q Q Q
installed on a domain Account 1 Account 2 Account 3
controller

(4) Password updated on each
target server using the SEM
agent

(1) An end-user changes their password on their login machine. They use either
the Password Synchronizer ‘Console’ program from Sysgem to change their
password, or they use the standard operating system procedures and let the
Password Synchronizer ‘intercept’ the password change.

(2) New passwords are sent to the SAcM Password Synchronizer Controller
which (3) checks the Rules Database to determine whether each new password
should be distributed, and if so to which target systems it should be sent.
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All network traffic is heavily encrypted to ensure that passwords cannot be
detected by network monitoring devices.

(4) The Controller sends new passwords to the SEM Agents running on the target
systems and the password is updated for:

e the appropriate operating system accounts on those systems,
e optional third-party application accounts such as ORACLE or MySQL.

(SEM Agents are part of the System Enterprise Manager and are installed using
the platform-dependent kit.)
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Components

There are three components that need to be installed on different systems:

e  SAcM Password Synchronizer End-User Components (Interceptors,
Console)

where the end-users change their password.

e SAcM Password Synchronizer Controller

on at least one Windows system used for password
distribution.

e SEM Agents

where the end-user passwords are to be changed by the
password synchronizer controller.

SAcM Password Synchronizer End-User
Components

End-User Components consist of the SAcM Password Synchronizer Console and
the SAcM Password Synchronizer Interceptor:

e The Console is a Sysgem-provided program that provides a
command line prompt for a new password. It first changes the
user’s password in their local account and then sends the new
password to the SAcM Password Synchronizer Controller.

e The Interceptor is a Sysgem-provided program that ‘listens’ for
passwords being changed by the normal operating system
procedures and sends the new password to the SAcM Password
Synchronizer Controller.
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Controller IP address and
Q — —  port defined in local
user configuration files.
Console on
Windows
Workstation
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PwdSync controller and
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Interceptor on

Windows
Domain
Controller
or

Q E| Windows UNIX OpenVMS

user
Interceptor on

OpenVMS 1 or more 1 or more 1 or more
Accounts Accounts Accounts

Interceptors are currently available for the Windows XP/2000/NT and for the
OpenVMS platforms. On OpenVMS they intercept password changes only when
a user is forced to change an expired password during login.

The Interceptor and Console have configuration files that identify the location of
the SAcM Password Synchronizer Controllers. If a Controller is unavailable for
any reason, then the next one in sequence will be used.

On systems where the user will change passwords you install:

e Interceptor (Windows and OpenVMS only): to intercept a
password that has been changed with the normal operating system
procedure.

e Console programs (all platforms): a Sysgem program that prompts
a user for a new password.

In Windows domains a domain password is changed on the Domain Controllers.
Passwords used in Windows workgroups are local account passwords and are
changed on the user's own workstation.

The normal use of Password Synchronizer is to intercept domain passwords and
therefore the Interceptor is normally installed on all Domain Controllers. In an
NT 4 domain install the Interceptor on the Primary Domain Controller (PDC).
You may also install it on Backup Domain Controllers in case those should ever
be promoted to a PDC.
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SAcM Password Synchronizer Controller

The Password Synchronization Controller is installed on one or more Windows
systems (workstation or server). It receives new passwords from the End-User
Components and forwards them to target systems in accordance with the rules in
a Rules Database. It should be installed on Windows Servers that are normally
always available.

There are two parts to the controller:
1. The Windows service SEM Password Synchronization Controller and
2. The Controller Interface.

The service runs all the time, you use the controller interface to configure the
service, display logfiles etc.

The interceptors are configured with a list of controllers to which password
changes are sent. The interceptor tries each controller in turn until one is found
which accepts the password change information.

The interceptor then remembers the controller which accepted the message and
tries this one first when the next message is sent.

SEM Agents

System Enterprise Manager (SEM) agents are used as part of a SAcM Password
Synchronizer installation to update the user accounts on the target systems.

These SEM agents must be installed on all the target systems where the
passwords are to be updated.

The SEM Agents are installed using the standard SEM agent kit for the
respective platforms.
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Summary

The SAcM Password Synchronizer components can be summarized as follows:

Available Component | Description
Platform

Windows Interceptor This intercepts password changes made using any
Windows program and forwards the new passwords
to the Controller.

It comprises of a DLL in the System32 directory that
is called when a user changes a password.

This must be installed on the system where the
password is located; if in a domain then this is the
PDC and BDC - all domain controllers.

OpenVMS Interceptor This intercepts password changes using LOGINOUT
and forwards the new passwords to the Controller.

A shareable image that uses the LOGINOUT (LGI)
routines as described in the COMPAQ OpenVMS
Utility Routines Manual to support a custom login
program.

Windows Controller The program that receives password change requests
processes them and distributes the changed
password.

Installed on one or more secure Windows systems.
These do not have to be the Domain Controllers but
usually are.

The interceptor attempts to send the requests to each
Controller in turn until an available Controller is
found.

There are two parts to the controller: a Windows
service SEM Password Synchronization Controller
and a Controller Interface.

The service runs all the time, you use the controller
interface to configure the service, display logfiles
etc.

Windows Console A small utility program with which the user requests
UNIX a change of password. The Console communicates
directly with the Controller.

OpenVMS
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Quick Start

Overview

Kits
The Kits you need are:
e Sysgem Password Synchronizer (SPS), and

e Sysgem Enterprise Manager (SEM) - specifically the platform-specific
agents.

These are two separate Kits, obtainable from you reseller or downloadable from
Sysgem’s website http://www.sysgem.com/ .

Kits requires a password to proceed with the installation, passwords are available
from your reseller or Sysgem support mailto:support@sysgem.com .

Steps

To implement the Password Synchronizer in your environment you:
1. Look at the typical topology shown on page 1.

2. Install the Sysgem Password Synchronizer (SPS) components on the
systems (see Installation on page 9):

a.  Where the users change their passwords:

i. Interceptors on all domain controllers (when you
install the Interceptor a reboot will be required),

ii. Console on workstations (optional on Windows).
b. Where the password will be distributed:

i. Controller, usually on one or more domain controllers
or other high-availability servers.

3. Configure the interceptors and consoles (see Console on page 51 and
Windows Interceptor on page 53).

4. Install SEM Agents on the systems where the new password will be
updated by the SPS controller (see SEM Agents on page 15).

5. Start the SPS Controller to define agents and rules (see Agent
Definitions on page 41 and Rules Definitions on page 45).
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Installation

Installation of SPS.

1. Install the SPS Controller on the high-reliability secure systems you
will use for password distribution. The SPS Controller receives change
requests and distributes them through your network to SEM Agents
which update passwords.

2. Install the SPS Interceptors on the computers where users will change
their passwords, for Windows this will be all domain controllers.

3. Optionally install the SPS Console on the computers where users are to
change their password from the command line (DOS, terminal
window).

Installation of SEM Agents. This is a standard installation, no special options are
required. You should be familiar with SEM — if not please contact your reseller
or Sysgem support.

1. Install the SEM Agents on the computers where the password will be
updated by the SPS Controller(s).

Configuration
After installing SPS and the SEM agents you must:

e  Configure optional consoles (page 51),

e  Configure Windows Interceptors (page 53), and

o Define the Controller Database (page 41) which contains:
o Agent definitions (page 41) and
o Rules (page 45).
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Installation

Database Updates

The password synchronizer automatically updates the database (if necessary)
when a new version of SPS is installed.

SAcM Password Synchronizer

Windows

The Windows kit is SYSGEMiPwdSync.exe, if you have downloaded from the
web it will be part of the PwdSyncAllKits_Build<nnnn>.zip archive where
<nnnn> is the build number, for example 2619.

Before starting the installation you should plan where you will install the various
components, refer to page 1 of this guide for more information
Password

When you start the installation you are prompted for the password. If you do not
have a password contact your distributor of Sysgem AG.

The standard password is Ford GT40 but this may change in future releases.

SEM Password Synchronization - InstallShield Wizard

Password U

Enterthe password required o run this setup. Please note that passwords are case sensitive. Click
Mext to continue.

This setup has been password protected.

Mext > | ’ Cancel
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Welcome

SEM Password Synchronization - InstallShield Wizard ﬁ

Welcome to Sysgem Password Synchronization

The Sysgem Password Synchronization will be installed on
wour computer. To continue press Next.

| Next > | ’ Cancel

A greeting from the development team. Press Next to continue.

License Agreement

SEM Password Synchronization - InstallShield Wizard

License Agreement

Please read the following license agreement carsfully.

IMPORTANT: Before commencing using the SY'SGEM Products, carefully read the following
terms and conditions which have been accepted
by your company ("Licensee").

?

1. GRANT OF LICENSE. SYSGEM AG ("SYSGEM") hereby grants to Licensee ("ou™) and You
accept a nonexclusive license ("License") to use the SYSGEM Products delivered pursuant and
subjectto this Agreement The SYSGEM Products as identified in the applicable purchase order
consists of (a) computer modules delivered in object code farm only ("Programs"). () an

installation guide and related printed documentation ("Documentation'). and (c) any entitled

updates ('Updates"). The Frograms and Documentation (PDF format) are delivered on

magnetic diskis). tapels) ar CO-ROM ("Media"). vYou agree that vou will not assian. sublicense

or otherwise transfer your right under this Agreement without the prior written consent of SY'SGEM. [v]

(@) acceptthe terms of the license agreement
()1 do not accept the terms of the license agreemeant

InstallShield

I < Back | et > | I Cancel l

Displays a dialog box containing a license agreement. You can scroll up and
down to read the agreement, then must choose either | accept..., | do not
accept..., or the Back button. If you select 7 accept..., Setup will continue. If you
select I do not accept..., Setup will display the Exit Setup dialog.

Read the license agreement carefully, then press Next to continue.
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Customer Information

SEM Password Synchronization - InstallShield Wizard
Customer Information %
FPlease enter your information. S 5

Flease enteryaour name and the name of the company for which you wark,

User Mame:

Sirnon Brown

Company Mame:

Sysgem AG

[ <Bak | mea> | [ cancel |

Displays a dialog box that retrieves the user name and company name. Setup
obtains the user name and company name from the registry. The Next button
becomes enabled only when data exists in both edit fields. If Setup can locate
default name and company values from the system, the Next button is
automatically enabled.

Enter your name and the name of the company you work for, then press Next to
continue.

Destination Location

SEM Password Synchronization - InstallShield Wizard
Choose Destination Location M
Select folder where setup will install files | - -

G Install SEM FPassword Synchronization to:

CAProgram Filesi Sysgem

’ < Back | Tlext > | ’ Cancel l

Displays a dialog box that allows you to select an alternate destination path.
When you click the Browse button in that dialog box, the Choose Folder
window is called to open a second dialog box that enables you to either select an
existing folder or to enter a new folder name.

If you enter the name of a folder that does not exist, a message box is displayed
asking whether to create a folder with that name. If you select yes, the specified
directory is created.
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If the default folder does not already exist on your system, it will not be created
unless you press the Browse button and follow the steps to create it from the
Choose Folder dialog box.

Select the folder where the files will be installed, then press Next to continue.

Program Folder

SEM Password Synchronization - InstallShield Wizard
Select Program Folder 1
' bl

Setup will add program icons 1o the Program Folder listed below. You may type a new folder name,
or selectone from the existing folders list. Click Next to continue.

Flease select a program folder.

Program Folder:

Swysgem

Existing Folders:

ScanSoft OmniPage SE
Skype

Sonic

Sony Ericsson
Soundhdax

SPI Software
SOL<mML 40

Starup

Subhash WCDFlayer 2.3 -
Sysgem >

’ <Back | x> | ’ Cancel l

Displays Start menu program folders for selection. The default folder is
SYSGEM. You can also enter a new folder name.

Select the program folder where the startup icons will be added, then press Next
to continue.

Select Features

SEM Password Synchronization - InstallShield Wizard

Select Features %

Select the features setug will install. I .

Select the features you want to install, and deselect the features you do notwarnt to install.

[]Consale Description
Contraller The password interceptor,

[ Interceptar installed on domain contrallers

767 MB of space required on the C drive
9274.38 MB of space available onthe C drive

’ <Back | Mext> | ’ Cancel l

The Console program is an optional command-line (DOS) program which
prompts for a new password. Install on a user’s workstation.

The Interceptor ‘listens’ for passwords being changed by the normal operating
system procedures, it is installed on all domain controllers (which is where the
password is actually changed).

The Controller is installed on one or more Windows systems (workstation or
server), usually Windows servers that are normally always available.
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Select the features to install, press Next to continue.

Ready To Install

SEM Password Synchronization - InstallShield Wizard ﬁ

Ready to Install the Program

Thewizard is ready to begin installation

Click Install to begin the installation.
If wou want to review or change any of vour installation setings. click Back. Click Cancel to exitthe
wizard.
InstallShield
’ <Back [ sl ] ’ Cancel

If you are ready to start the installation press Install.

Setup Status

SEM Password Synchrenization - InstallShield Wizard ﬁ

Setup Status

SEM Password Synchronization is configuring your new software installation.

Installing

CA\Prograrn FileshSysgemSEM Perl\bin' SysgemAccess mdb

Installzhield

Cancel

While the software is being installed the Setup Status is displayed.
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Completed

SEM Password Synchronization - InstallShield Wizard

InstallShield Wizard Complete

SEM Password Synchronization Setup is almost complete.

Press Finish to complete SEM Password Synchronization Setup.

< BHarck Cancel

Press Finish to complete the setup.
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SEM Agents

Windows

The Windows kit is SYSGEMiWindowsNTAgent_Build<nnnn>.exe where
<nnnn> is the build number, for example 2610.

This kit is derived from the standard SEM Windows Kit, it is not password-
protected.

Welcome

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard ﬁ

Sysgem Enterprise Manager v2.0 build 2610

Created: Fricay April 1, 2005 at11:22

By Swsgem AG, Switzedand.

< Back | MNext > | I Cancel ]

Displays a dialog box that welcomes the end user. Press Next to continue.
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License Agreement

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard
License Agreement 5&
Please read the following license agreement carsfully. I - -

IMPORTANT: Before commencing using the SY'SGEM Products, carefully read the following ”~
terms and conditions which have been accepted I
by your company ("Licensee").

1. GRANT OF LICENSE. SYSGEM AG ("SYSGEM") hereby grants to Licensee ("ou™) and You
accept a nonexclusive license ("License") to use the SY'SGEM Products deliverad pursuant and
subject to this Agreement. The SYSGEM Products as identified in the applicable purchase order
consists of (&) computer modules delivered in object code form only ("Programs"). (b) an
installation guide and related printed documentation ("Documentation'). and (c) any entitled
updates ('Updates"). The Programs and Documentation (FDF format) are delivered on

magnetic disk(s), tape(s) or CO-ROM ("'Media"). You agree that vYou will not assign, sublicense

or otherwise transfer your right under this Agreement without the prior written consent of SYSGEM. |

(Ol acceptthe terms of the license agreement

()| do not accept the terms ofthe license agreement

Displays a dialog box containing a license agreement. You can scroll up and
down to read the agreement, then must choose either I accept..., | do not
accept..., or the Back button. If you select I accepz..., Setup will continue. If you
select | do not accept..., Setup will display the Exit Setup dialog.

Read the license agreement carefully, then press Next to continue.

Customer Information

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard
Customer Information gn
Flease enteryour informatian. I - —

Flease enteryour name and the name of the company for which you work.

User Name:

Siman Brown

Company Mame:

Swysgem AG

’ < Back I MNext » l ’ Cancel l

Displays a dialog box that retrieves the user name and company name. Setup
obtains the user name and company name from the registry. The Next button
becomes enabled only when data exists in both edit fields. If Setup can locate
default name and company values from the system, the Next button is
automatically enabled.

Enter your name and the name of the company you work for, then press Next to
continue.
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Destination Location

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard

Choose Destination Location

Select folderwhere setup will install files I = —

G Install Sw=gem Enterprise Manager (Agent Only ta:

C\Program Files\Sysgem

’ <Back [ MNext> | ’ Cancel l

Displays a dialog box that allows you to select an alternate destination path.
When you click the Browse button in that dialog box, the Choose Folder

window is called to open a second dialog box that enables you to either select an

existing folder or to enter a new folder name.

If you enter the name of a folder that does not exist, a message box is displayed
asking whether to create a folder with that name. If you select yes, the specified

directory is created.

If the default folder does not already exist on your system, it will not be created

unless you press the Browse button and follow the steps to create it from the
Choose Folder dialog box.

Select the folder where the files will be installed, then press Next to continue.

Agent for Windows Account

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard

Agent for Windows Account

Selectthe accountused for the 'Agent for Windows' service.

(O Local System (®) Other (Below)
Account: SYSGEM-ZH\Frodo
Paseword: [TITIT]

Caonfirm: sssase

[ ] Create accourt if it does not exist

’ < Back | Next > | ’ Cancel l

To correctly change a password the agent requires the privileges normally
granted to members of the Administrators group.

Enter the account and password, then press Next to continue.

Sysgem Password Synchronizer User Guide (Rev1)
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Agent for Windows Port

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard ﬁ

Agent for Windows Port

Enter the SEM Agent for Windows port number, the defaultis 7257,

Puort: 7281

’ < Back MNext > | ’ Cancel

Enter the port number, the default is 7251.

Security Key

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard ﬁ

Security Key

Enterthe security key, this value is mandatory.

Key: [LITTT]

Confirm: [LLTL L]

’ < Back l Mext > l I Cancel ]

The SEM components use a Security Key to protect the system from
unauthorized components being introduced into the network.

Enter the mandatory security key, then press Next to continue.
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Ready To Install

SEM Password Synchronization - InstallShield Wizard ﬁ

Ready to Install the Program

The wizard is ready to beqgin installation.

Click Install to begin the installation.
If wou want to review or change any of vour installation settings. click Back. Click Cancel to exitthe
wizard.
InstallZhield
’ < Back | Install | ’ Cancel

If you are ready to start the installation press Install.

Setup Status

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard ﬁ

Setup Status

Sysgem Enterprise Manager (Agent Only) is configuring your new software installation.

Installing

C:AProgram FileshSysgem\SEM Perl\hintsysgem_smip.dil

InstallShield

Cancel

While the software is being installed the Setup Status is displayed.
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Completed

Sysgem Enterprise Manager (Agent Only) - InstallShield Wizard

InstallShield Wizard Complete

Sysgem Enterprise Manager (Agent Only) Setup is almost
complete.

Press Finish to complete Sysgerm Enterprise Manager (Agent Only)
Setup

Press Finish to complete the setup.

UNIX/Linux

Introduction

Sysgem provide a common installation procedure for all UNIX/Linux platforms
supported by Sysgem Enterprise Manager.

First, to install the SEM Agent on Unix/Linux systems, you need to be logged
into a privileged account, such as root.

You will then need to decompress the tar archive containing the installation Kit.
It is suggested that a special directory is created for this purpose.

Invoke the installation procedure by running the “setup” program unpacked from
the above tar file:

#./setup

The installation procedure prompts for the following information:

The location to install the agent, is by default the following:
/opt/Sysgem/SEM.

The TCP/IP port number. By default this will be 7251. It should
only need to be changed if 7251 clashes with one already in use.

A security key. This must be the same key used for all other
components on your network. It is a free-format text phrase that
(similar to a password) is defined by you during the installation. It
can be changed later if required. The example below uses a text
phrase of “FortKnox”.

Whether to start the Agent automatically on reboot.

Whether to start the Agent automatically on completion of the
installation.

An example is given below showing a typical installation on a Compag Tru64

machine.

20 e Installation
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To re-install the kit, perhaps as an upgrade for a later version, simply re-run the
above procedure. There is no need to stop any daemons as these will be stopped
and restarted automatically during the installation.

If you have any suggestions for improving the UNIX installation of Sysgem
Enterprise Manager please contact our Online Support via
http://www.Sysgem.com - your input is valuable.

Example

The following example shows the installation on Compaq Tru64, having first
unpacked the tar archive into a directory /kits/SEM_Kit.
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# ./setup
SEM Agent for UNIX

Platform is OSF1

Data file is kit.4

Creating /kits/SEM kit/tmp

Copying kit.4 to /kits/SEM kit/tmp
Changing to /kits/SEM kit/tmp
Unpacking kit.4

Removing temporary files

8
7
6
5
4
3
2
1] Launching SEMInstaller

1
1
]
]
1
1
]
]

Sysgem SEM Agent UNIX Installer

Agent ......: Sysgem SEM Agent v2.0 build 1165
Target .....: OSF1l

Hostname ...: DigUnix.Sysgem.ch

Processor ..: alpha

Step 1/6 - Checking Inventory
Unpacking data.0...
Step 2/6 - Directory

Enter the directory where the agent is to be installed.
The recommended default is /opt/Sysgem/SEM

Enter the directory [/opt/Sysgem/SEM]

Step 3/6 - Port Number
Enter the TCP/IP port number. The default is 7251.

Enter the port number [7251]

Step 4/6 - Security Key
This product uses a powerful security model to guard against attack.
As part of the installation you MUST enter a security key.
The key is a free format text string (case sensitive) which is unique
in your network and MUST be the same as that entered for other components
of this product on your network.

Enter the security key [] FortKnox

Step 5/6 - Autostart

If you want the agent to start when you boot this system then enter YES,
otherwise NO.

If you select NO then you must start the agent interactively each time
you boot this system.

Start the agent when the system boots? [Yes]
Step 6/6 - Start Agent

If you want to use the agent now then it must be started after the,
installation is complete.

If you do not start the agent now then you must start it by either rebooting
the system (if you have selected this option) or by starting it interactively.

Start the agent after the installation? [Yes]

Confirmation
Directory .....: /opt/Sysgem/SEM
Port number ...: 7251
Security key ..: FortKnox
Autostart .....: Yes
Start agent ...: Yes
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Is this correct? [Yes]
Start the installation now? [Yes]

Creating Directory
/opt... Exists
/opt/Sysgem... Exists
/opt/Sysgem/SEM. .. Exists
/opt/Sysgem/SEM/library... Exists

Stopping Agent
If the agent is running it will be stopped.
Agent process: 543 root 0:00.07 /opt/Sysgem/SEM/SysgemSEMAgent
Stopping agent, pid=543, status=Success

Copying Files
SysgemSEMAgent. ..
SysgemSEMAgent.cfg... Exists (not overwritten)
SysgemSEMStart...
SEMInstaller...
ssm-accounts...
ssm-commander. . .
ssm-perf...
ssm-syslog...
AddStartup...
RemoveStartup...
init.tcl...

Installing Security Key
Installing SCSA Security Key

Index ....: 0

Value ....: FortKnox

File .....: /opt/Sysgem/SEM/Digital security key O.arc
Status ...: OK

Updating Autostart Tables
Removing: /sbin/rc3.d/S99Sysgemn. ..
Removing: /sbin/init.d/SysgemSEMStart...
Copying: /sbin/init.d/SysgemSEMStart...
Linking: /sbin/rc3.d/S99Sysgen...

Starting The Agent
PID USER TIME COMMAND
664 root 0:00.07 /opt/Sysgem/SEM/SysgemSEMAgent

Installation completed.
#
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The above example from an installation on Tru64 is true for all variants of
supported UNIX systems except IBM AIX.

The Autostart procedures are different for AIX. The "Updating Autostart Tables"
section of the AIX installation displays the following:

Updating Autostart Tables
Inittab Entry

Sysgem sem:2:wait:/opt/Sysgem/SEM/SysgemSEMStart

Files Installed

Root Directory:

Platform Directory
AlIX /opt/Sysgem/SEM
COMPAQ (Digital) /opt/Sysgem/SEM
HP /opt/Sysgem/SEM
LINUX Intel /opt/Sysgem/SEM
SUN Solaris /opt/Sysgem/SEM
Agent Files:
File Description
AddStartup Adds the agent to the system’s initialization
tables.
RemoveStartup Removes the agent from the system’s

initialization tables.

Sysgem-Agent-Logfile-Oct-00.txt

The agent logfile for October 2000.

SysgemSEMAgent

The agent executable image.

SysgemSEMAgent.cfg

The configuration file, contains entries
which overwrites the default settings:

Port number - the default is 7251.
Debug level - the default is 0.

Temporary directory for script files - the
default is Sysgem_Script_<machine name>

SysgemSEMStart

The startup script that is invoked as part of
the system initialization.

library/init.tcl

Required by ssm-commander (below).

ssm-accounts

A support module that lists the contents of
the password and group files.

ssm-commander

A support module used to run UNIX
commands that prompt the user for input.

ssm-perf A support module that returns performance
information - CPU loading, memory usage
and list of processes.
ssm-syslog A support module which returns entries from
the syslog database.
AutoStart

So that the agent starts when the system is booted you must add entries to the

initialization tables.

To make life easy, two files are provided in the root directory: AddStartup and

RemoveStartup.
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AddsStartup is platform-dependent, as follows:

Platform Method

AlIX Adds an entry to /etc/inittab (see inittab(4)
for more information).

An example of the /etc/inittab entry is shown
below:

Sysgem_sem:2:wait:/usr/sbin/SYSGEM/SEM
/SysgemSEMStart

COMPAQ (Digital) Copies SysgemSEMStart from the root
directory to /shin/init.d/SysgemSEMStart,
then creates a symbolic link
/sbin/rc3.d/S99Sysgem to SysgemSEMStart.

HP Copies SysgemSEMStart from the root
directory to /sbin/init.d/SysgemSEMStart,
then creates a symbolic link
/sbin/rc3.d/S99Sysgem to SysgemSEMStart.

LINUX Intel Copies SysgemSEMStart from the root
directory to /etc/init.d/SysgemSEMStart if
possible, otherwise to
[etc/rc.d/init.d/SysgemSEMStart, then
creates a symbolic link
Jetc/rc.d/rc3.d/S99Sysgem to
SysgemSEMStart.

SUN Solaris Copies SysgemSEMStart from the root
directory to /etc/init.d/SysgemSEMStart, then
creates a symbolic link /etc/rc3.d/S99Sysgem
to SysgemSEMStart.

OpenVMS

The OpenVMS agent is installed using VMSINSTAL.
The saveset containing the agents for both Alpha and VAX is VMSSVR020.A.

The saveset is saved as a zip file. You must unzip this file on an OpenVMS
system to restore the original file attributes of the saveset.

If you do not have “Unzip” on OpenVMS, a copy of the Alpha and VAX unzip
programs can be found under the “Extras” folder on the CD, or downloaded
from the Sysgem website Download zone. Copy the appropriate one of these
programs to your system, and define a “Foreign Command” to run the unzip
program, e.g. after copying the file UNZIPAXP.EXE to SYSSMANAGER on an
Alpha-VMS system, and the VMS_AGENT_020_A.ZIP zip archive file to a
temporary directory, enter the following

$ UNZIP :== $SYSSMANAGER:UNZIPAXP.EXE
$ UNZIP VMS_AGENT_020_A.ZIP

If you have received the saveset inside a zip file, then you must either unzip this
file on an OpenVMS system to restore the original file attributes of the saveset,
or invoke the command file ATTRIBUTES.COM.

The default OpenVMS agent port is 7251.

To override the default define the logical SEM-SERVER-PORT-NO before
starting the agent.

To set the OpenVMS port to 7000 enter:
$ define SEM-SERVER-PORT-NO 7000
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Example Installation
To install SEM, Log in the System account and type the following:

$ @sys$update:vmsinstal VMSAGENTO020 products:[Sysgem.kits]
An OpenVMS v 6.1 installation logfile is shown below.
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$ @sysSupdate:vmsinstal vmsagent020 SYSSSYSDEVICE: [SCHOFIELD.SYSGEM.BUILD 1190 i

OpenVMS AXP Software Product Installation Procedure V6.2-1H3

It is 16-MAY-2001 at 16:11.

Enter a question mark (?) at any time for help.
SVMSINSTAL-W-NOTSYSTEM, You are not logged in to the SYSTEM account.
SVMSINSTAL-W-ACTIVE, The following processes are still active:

UCXSNTPD

ucx$esnmp

ucx$os_mibs

UCXSFTPD

UCXS$FTPC 1

SEM-AGENT-AXP

SEM-AGENT-AXP

The following products will be processed:

VMSAGENT V2.0

Beginning installation of VMSAGENT V2.0 at 16:11
$VMSINSTAL-I-RESTORE, Restoring product save set A

R R R R R R R R R

* *
* Installing agent for ALPHA *
* *

R R R R R R R R R R

Rk kb bk b b b b b b b b b b b b b b b b b b b R b b R b b b

* *
* A directory will be created to store the agent files. *
* *

Rk kb kb b b bk b b b b b b bk b b b b b b b b b R b b

-> If you are installing on a cluster then the directory
must be created on a disk which is mounted cluster-wide.

-> If you change this directory after you have installed this
product you must also update:

*  SYSSSTARTUP:SEM-AGENT-STARTUP.COM
-> See the User Guide for more information.

* Enter the device and directory [SYS$SYSROOT: [SYSGEM-SEM-AGENT]]:
$VMSINSTAL-I-SYSDIR, This product creates system disk directory SYS$SYSROOT: [SYSGEM-
SEM-AGENT] .
$CREATE-I-EXISTS,

SYS$SYSROOT: [SYSGEM-SEM-AGENT] already exists

Installed Files

SEM-AGENT-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-ACCESS-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-ACCOUNTS-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-AUDIT-EVENT-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-AUDIT-TRAIL-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-PERF-INFO-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-PROCESSES-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-QUEUES-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SSM-SECURITY-AXP.EXE will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SEM-AGENT-STARTUP.COM will be created in SYS$STARTUP

SEM-START-AGENT .COM will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SEM-STOP-AGENT .COM will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
SEM-DEINSTALL.COM will be created in SYS$SYSROOT: [SYSGEM-SEM-AGENT]
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R R R R R I I I I I I b dE h E E b b E E b b b h E kb b b b b b b b 3k

* *
* SECURITY - Installation Key - SECURITY. *
* *

R R R R R I I I I I b b h E b E E b b b b h kb b b b b b b 3k

This product uses a powerful security model to guard
against attack.

If this is the first time that you have installed this
agent on this host then you must enter a key.

The key is a free format text string (case sensitive) which is
unigque for your network and MUST be the same as that entered for
other software components of this product on this network.
For more information read the user guide.

* Enter the security key: FortKnox

Installing Security Key...

Sysgem SEM Agent v2.0 build 1190
Copyright (c) 2000 by SYSGEM AG.

Initializing logfile

Filename ...: PIPPINSDKAO:[SYSO.] [SYSGEM-SEM-AGENT.12-60]SysGem-Agent-Logfile-Ma
Status .....: S$RMS-S-NORMAL, normal successful completion
Cluster nodename .....: PIPPIN

DECNET address .......: 12.60

OpenVMS version ......: V6.2-1H3

Hardware type ........: ALPHAbook 1

Active CPUs ..........: 1

Username .............: SCHOFIELD

Process name .........: SCHOFIELD

Process id ...........: 000000OAD

Base priority ........: 4

Working set extent ...: 32768

Paging file quota ....: 400000

Software version .....: Sysgem SEM Agent v2.0 build 1190
SCSA compliant .......: Yes

Build date ...........: May 2 2001 at 12:47:09

Installing SCSA Security Key

Index ......: 0

Value ......: FortKnox

Filename ...: PIPPINSDKAO:[SYS0.] [SYSGEM-SEM-AGENT.12-60]security key O.arc;1
Status .....: OK

The selected agent startup command files will be
added to the SYSMAN startup database.

Enter YES to add this file (recommended) :
$ MCR SYSMAN STARTUP ADD FILE SEM-AGENT-STARTUP.COM /PHASE=END

Enter NO to remove this file (if registered):
$ MCR SYSMAN STARTUP REMOVE FILE SEM-AGENT-STARTUP.COM /PHASE=END

* Enter YES or NO [YES]? YES
* Start the agent now ? [YES]? YES

Agent startup file

Copyright (c) 1998-2000 SYSGEM AG.

Pl - port number
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You can also override the default port numbers by defining a logical name
before calling this file.

Logical name: SEM-AGENT-PORT-NO

Example: $ define /system SEM-AGENT-PORT-NO 7000

EXECUTABLE ...: SYS$SSYSROOT: [SYSGEM-SEM-AGENT]SEM-AGENT-AXP.EXE

Start New Process

$RUN-S-PROC_ID, identification of created process is 000000AF

KA KA A KA KA KA KA A A A KA A A KA A A A A A A A A A A A A A A A A A A A A A A A AKX KKK

* *
* Installation successfully completed *
* *

KKK KK KA KA KA A A KA A A A A A A A A A A A KA A A A A A A A A A A A AR AR AN KA KA KA K

Installation of VMSAGENT V2.0 completed at 16:12
Adding history entry in VMIS$ROOT: [SYSUPD]VMSINSTAL.HISTORY

Creating installation data file: VMISROOT: [SYSUPD]VMSAGENTO020.VMI DATA

VMSINSTAL procedure done at 16:13

Files Installed

SYS$STARTUP:
File Description
SEM-AGENT-STARTUP.COM Invokes the start-up file SEM-AGENT-

AXP.COM located in the SEM Agent
work directory.

SYS$SYSROOT:[SYSGEM-SEM-AGENT]:

File Description

nn.nn.DIR /A subdirectory is created in the SEM
root directory to provide a machine
specific area into which temporary
work files will be stored, or files that
need to be machine specific for any
reason, in a clustered OpenVMS
environment.

“nn.nn” is the DECnet executor node
(area and number), and is system

specific.
SEM-AGENT-AXP.COM A command file to start the agent process
(as a detached OpenVMS process).
SEM-AGENT-AXP.EXE The SEM agent executable image.
SEM-AGENT-AXP.LIS This gives a log file of the current Agent

session. It begins a log of the start-up
command file, giving information such as
TCP/IP port in use, which security keys
have been defined, TCP/IP address, etc.

Sysgem Password Synchronizer User Guide (Rev1) Installation e 29



SEM-DEINSTALL.COM

A command file for removing SEM from
the system.

SEM-START-AGENT.COM

SEM-STOP-AGENT.COM

Command files that may be used to
manually stop and restart the agent
process.

SSM-ACCESS-AXP.EXE
SSM-ACCOUNTS-AXP.EXE
SSM-PERF-INFO-AXP.EXE
SSM-PROCESSES-AXP.EXE
SSM-QUEUES-AXP.EXE
SSM-SECURITY-AXP.EXE

SEM executable images to return data
such as file access, user accounts, Audit
Journal, performance, OpenVMS
processes, queues, security. These images
will be invoked from script files
transmitted from the SEM client and will
return data for display into the SEM
display windows.

SSM-AUDIT-EVENT-AXP.EXE
SSM-AUDIT-TRAIL-AXP.EXE

SEM executable images used for
recording information into and extracting
information from the OpenVMS audit
journal files. This information gives
details of the SEM user when transaction
are conducted on this OpenVMS machine
at the request of the SEM user logged into
the SEM Management Console
workstation.

(The default SYS$SYSROOT:[SYSGEM-SEM-AGENT] can be changed during

installation).

30 e Installation

Sysgem Password Synchronizer User Guide (Rev1l)




Controller Interface

Database Updates

The password synchronizer automatically updates the database (if necessary)
when a new version of SPS is installed.

Starting

The Controller Interface is used to configure and manage the Controller, the
processing of password change requests is performed by the Controller Server.

Start the Controller Interface from the Windows Start menu (the default entry is
Start > Programs > Sysgem > Pwd Sync > Controller).

A window will start similar to the following:

- SEM Pwd Sync Controller: Live Mode
Bl Edt Vew Controkr Agents Rules Logfie Optors Window bisp

4 3 E| 4 [] ) 57 4 ¥ * et
Suemim Cumeing  Refrh A Dalee  \imer | Colgme |MmoEwans| Top  omm  Clew | SoEian
2| @a (8 F m T o R

Logfile  Agert DefnsRule Defns Erief Logging| Full Logging | Live Mode | Test Mode  Security Keys  Scripts

Type Platform Name Enable Address Port Members Description
A Agent UNIX Linux 001 Yes 127.0.0.1 7251 Linux
A Agent UNIX Linux 002 Yes 127.0.0.1 7251
@ Agent Windows 11 Yes 11 7251
@ Agent iR
& Agent wiES
Type Enable From Except To oOptions Comment Timestamp
# Normal Yes LT Linux 001::host::* 43F1-F194-0182
# Normal Yes Windows Dummy::host::Fred666 439E-TEDE-DOEA

® Controller: Logging = Brief, Auto-updates = Off

= 24 \\3vrZ000\Disk\Program Files\Sysgem\SEM Pwd Sync\SEM PwdSync Logfile 2006-02-14 15-11-11.txt A
< Environment variables

Current directory ...:

Parent dirsctory

perl directory ....

\Program Files\Sysgem\SEM Pwd Synch

C:\Brogram Files\Sysgem\

C:\Program Files\Sysgem\SEM Perlibin

utilities directory C:\Program Files\Sysgem\SEM Utilities

Current PATH ... C:\WINNT\system32;C:\WINNT;C:\WINNT\System32Z\When;C:\Program Files\Microsof
Setting PATH to ..... ci\Program Files\Sysgen\SEM Perl\bin;C:\Program Files\Sysges\SEM Urilities;:
EATH i5 oW .........: C:\Program Files\Sysgem\SEM Perl\bin:C:\Program Files\Sysgem\SEM Utilities;

+ Network Adapters
Address used ..: Yes

Value used ....: 7584-A471-B4EF-AZBG-8367- 0CAE-AIFS-8EA0
Unit index ....: 0
MAC Address ...: 7584-A471-B4EF-A2BI-8367-0CAE-AJFS-BEAD
Description ...: SVR2000
< >
Ready Controllr Stopped Mode=LIVE Password Vakdation=0FF

Brief vs. Full

Only use Full mode for debugging purposes, this adds copious script information
to the logfile. Once password synchronisation is running make sure you have
Brief selected.

Live vs. Test
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In test mode everything runs as normal except that the scripts are not executed
on the remote SEM agents. Make sure you leave the controller running in test
mode when you have finished testing!

Options

The options available from the menu and toolbar are:

Option Icon | Menu Description

Logfile | | Logfile > Displays the Logfile window.
\_w Display

Agent Defns 4 Agents > Displays the Agents Definitions window.
=% | Display

Rules Defns

Rules > Display

Displays the Rules Definitions window.

Start Service < | Controller > Start the service which listens for
Start incoming password validation and
change requests.
Stop Service .« | Controller > Stop the service.
| Stop

Select logfile

Logfile > Open

Open a logfile for display in this
window.

Brief tracing [ B] Controller > Enable brief tracing of messages and
Brief display to the logfile window.
Full tracing [ F ] Controller > Enable full tracing of messages and
Full display to the logfile window.
Live mode [ L ] Controller > Switches to live mode.
Live
Test mode [T ] Controller > Switches to test mode (scripts are sent to
Test the agents but are not run).
Security keys EI Options > Displays the Security Keys window,
Security Keys security keys must be defined so that
SEM agents can be used.
Scripts % Options > See below in the section Scripts.
~#0 | Scripts
Current logfile __:j. Logfile > Selects the currently active logfile.
2V | Current
Refresh logfile ﬂ Logfile > Refresh the contents of the window, if
=1 | Refresh new entries have been added to the

logfile then they are displayed.

Enable Auto-
updates

Options > Auto-
Update

If selected then new entries in the current
logfile are automatically displayed.

Erase current
disk logfile

Options > Erase
Current Logfile

Erase the contents of the disk logfile.

View current

Options > View

View the contents of the disk logfile with

disk logfile Current Logfile | Notepad.

Collapse )\ Logfile > Close all open branches in the logfile
| Collapse tree.

Expand on Error &7 Controller > Automatically open folders in the logfile
4 Expand on Error | window if the folder contains error text.

Top of window {_\I" Logfile > Top Move to the top of the window.

Bottom of {—/|7 Logfile > Move to the bottom of the window.

window Bottom
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Erase window X Controller > Erase the contents of the window.

contents Erase

Display window View > Logfile | Display the contents of the logfile

contents with _é" window with Notepad.

Notepad

Send window = Options > E- Set the contents of the window with e-

contents with e- mail Output mail.

mail

Close File > Close Close program — continues running in
the system tray.

Exit File > Exit Exit program (stops).
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Scripts

To display the settings window select the scripts icon in the toolbar or Options >
Scripts menu entry.

The only scripts you will edit yourself are:
e Custom (adding support for additional 3™-party products), and

e Password validation (if enabled).

Scripts — Common

When a script is create to change a password on a SEM agent the script is
prefixed with the platform-specific common code which contains the functions
used by the script.

& Scripts
Common | Custom | Executable | Main | Validation

These files contain platform-specific common code. The defaultvalues are usually sufficient. Press
'Edit' to edit afile.

A5400: DASecure\PwdSyn A TontrolledD. ACommon_AS400 txt | Select | ’ Edit
M DiSecurs\PwdSynciContrallenDe. \Common_yS td [ Select ” Edit
UNIX  DASecure\PwdSynci\ControllerDe. \Common_UNIXbd | Select || Edit
VMS: DiSecurs\PwdSynciContrallenDe. \Common_YMS b [ Select ” Edit
Windows: DASecure{PwdSynciCantroll. \Common_WINDOWS bt | Select || Edi

Load Defaults

X

[ oK ] l Cancel

l

Press Load Defaults to load the default files shipped with this product.

There are no user-definable values in these scripts.

Scripts — Custom

The custom scripts add support for third-party applications such as ORACLE.
The functions in the custom script files correspond to the options are defined in
Rules Database entries.

For each option which you define in a rule there must be a corresponding
Set_<option> function in the Custom scripts, for example if the option is
ORACLE then the function is Set._ OPTION. For more information see the
Custom scripts shipped with the Controller.
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& Scripts

Commaon | Custom | Executable | Main | Validation

These files contain platform-specific custom code used o support 3rd-party products such as
ORACLE. Press 'Edit' o edit afile.

A5400: DASecure\PwdSync\TontrolledDe. \Custom_AS 400t | Select | ’ Edit l
M DiSecurs\PwdSynciControlienDeb. \Custom_MVS bt [ Select ” Edit ]
UNIX  DASecure\PwdSynciControllerDeb. \Custom_UNIXbt | Select || Edit |
VMS: DiSecurs\PwdSynciControllenDeb. \Custom_VMS bt [ Select ” Edit ]
Windows: DiSecure\PwdSynciCantrolle. \Custom_WINDOWSt | selest || Edit |

l K, ] l Cancel l

A sample Windows script is shown below:

=+
#
#  Custom windows code. This appears after the common windows code.
#
# This code sets the password on 3rd party applications.
&
A
&
#  Set the ORACLE password (just an examplel.
#
# To enable this add the oracLE option when defining the rules database.
&
sub Set_ORACLE
{
my $username = $_[0];
my $password = $_[1];
print "{{sI Application ...: ORACLENN";
primt "{{5I Username ......: $usernamein";
print "{{5I Password ......: #FEEEEEN"
print "{{5I ORACLE: Mot wer supportedin’;
#*
#  add your code here.
&
¥

Scripts — Executable

The Controller scripts use Perl. For testing purposes only you can change the
default location where the Controller looks to find the Perl executable.
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Common | Custam EXBCUTﬂb|E|Main ‘alidation

This is the location of the SysgemPerl executable. tis weary strongly
recammended that wvou use the defaultvalue. (This option is prowvided for
diagnostic use by Sysgem AG)

[V]Use default (recommended)

0] 4 | l Cancel

Scripts — Main

This is the main script which runs when a change request is received. You can
define up to 5 different scripts but only one script can be active at a time. This is
to assist in developing new scripts and making it easy to switch between your
own script and the script supplied by Sysgem.

& Scripts

Commaon | Custom | Executakle | tain |\r’alidati0n

These files contain the main analysis code. The defaultvalue is usually sufficient. Press 'Edit' 1o edita
file, 'Remove' to remowve afile.

@1 D Secure\PwdSync\Controlle\De.. Main_analysis b l Select ” Edit ” Remowve l
(@) l Select l [ Edit l l Rermowve l
O3 l Select l [ Edit l l Remaowe l
4 l Select l [ Edit l l Rermowve l
(@] l Select ] [ Edit l l Femaowe ]

| Load Defaults
l QK ] l Cancel ]

Press Load Defaults to load the default files shipped with this product.

There are no user-definable values in these scripts.

Scripts — Validation

This is the script which runs in response to a password validation request. You
can define up to 5 different scripts but only one script can be active at a time.
This is to assist in developing new scripts and making it easy to switch between
your own script and the script supplied by Sysgem.
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Comman | Custom | Executable | Main | Yalidation
These files contain the password walidation code, by default password validation is disabled. Press
'E'to editafile. 'R to remove afile.
@1 DiSecurs\PwdSync\ConrallenD. \Pwd_Validationst | Select || Edit || Remove |
(@) l Select ” Edit ” Rermowve l
O3 l Select ” Edit ” Remaowe l
4 l Select ” Edit ” Rermowve l
(@] l Select ” Edit ” Femaowe ]

Enablevalidation

| oK | l Cancel ]

Press Load Defaults to load the default files shipped with this product.
The options you would typically change are:
e  Minimum length
e Maximum length
e  Password may not be same as username
Contact your reseller for more options.
To enable password validation:
e Check Enable validation in the Validation window (above).

e Make sure the validation script header contains the line: “use
constant PWD_ENABLE => 17”. If validation is disabled it will be
“use constant PWD_ENABLE =>0.”

e The Windows interceptor must have validation enabled, use the
Interceptor Configuration utility described on page 54.
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Controller Server

Overview

The processing of password change requests is performed by the Controller
Server, installed as the Windows service SEM Password Synchronization
Controller.

The server is also used to validate old Windows passwords when the Console
program is used. The server must be able to enable the privilege “Act as part of
the operating system”. To be able to do this the account used for the service must
use the Local System account or an account with the ability to enable the above
privilege.

All configuration and management is performed using the Controller Interface.

The service configuration is shown below:

SEM Password Synchronization Controller Properties (Local Co...

General I Log Dnl F!e-:over_l,ll Dependenciesl

Service name: SEM PwdSync Contraller
Digplay nanme: ISEM Pazzword Spnchronization Controller
Description: IEreated by Sysgem AG

Path to executable:
C:\Program Filez\SyzgemiSEM Puwd SynchSEMPwdSyncService exe

Startup type: Autamatic j

Service statuz:  Started

Start I Stop I Pausze Besume |

‘f'ou can specify the start parameters that apply when pou start the service
from here.

Start parameters: I

Cancel Apply
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Controller Database

Introduction

The database is maintained with the Controller user interface.
There are two displays:

e Agents, and

e Rules.

The database is accessed via ODBC, the DSN is Sysgem Pwd Sync. There is no
real need for a high performance database solution, Access (the default) is fine.

Multiple Controllers

If you are maintaining multiple controllers (which is recommended) consider
defining the database on one system then copying the database between
controllers or using a network/shared database such as SQL Server.

Structure Updates

Any changes to the database design are applied automatically when you install a
new version of the password synchroniser.

Changes

07-October-2004: With the addition of Options to the Rules Database the table
name has been changed from TABLE_RULES_V3to TABLE_RULES V4.
Existing entries in TABLE_RULES_V3 are copied to TABLE_RULES V4 if
TABLE_RULES V4 is empty.

21-December-2004: The Except rules field is now of unlimited length, as a
result the Rules Database the table name has been changed from
TABLE_RULES_V4to TABLE_RULES_V5. Existing entries in
TABLE_RULES V3 or TABLE _RULES V4 are copied to
TABLE_RULES_V5 if TABLE_RULES_V5 is empty.

Agent Definitions

This display maintains a list of agent and group definitions on each Windows NT
system where the password synchronization Controller is installed.
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Each agent entry defines a remote system to which the Controller sends
password changes (you must install the SEM Agent on each remote system).

Each group entry is simply a list of one or more agent definitions, for example
'‘Development Systems' or "Test Systems'. You can select a group as part of a
Rules Database entry (later in this chapter).

The agent and group definitions are used when you define rules (later in this
chapter).

You can even import definitions from the list of agents defined in the SEM
Management Console.

42 Agent Definitions Q@
Type | Plattorm | Name Enable | Address Port | Members Description
o Group Test Yes Bilbio, Boris, RedHat  Test systermns
@ Agent AS400 AS400 Yes 201421240 3140 AS400
r’} Agent  UNIX Al 415 Yes 2014212133 3133 Al 415
r’} Agent UMK AlE1 Yes 201421251 7251
,’} Agent  UNIX Digital Unix Yes 2014212150 3150 COMPAQ OSF1 w40
r’} Agent LINIX HF 715 Yes 2014212191 3191 HF workstation
2y Agent UNIX HF B180L Yes 2074212192 3192 HPFworkstation
r’} Agent UMK 1BM Al Yes 2014212188 3188 Al workstation
:} Agent LINIX RedHat Yes 201421280 7251 RedHat dewelopment system
EEE Agent WME Eilbo Yes 201421298 7251 Development system
EEE Agent wMS Frodo WS Yes 201421298 3093 WS
3 Agent VWindows Boris Yes 2014212101 7281 Development systerm
3  Agent \Windows Gandalf Yes  201.4212103 3103 Deweloprent machine PDC
3 Agent Windows NT-40-German  Yes 2014212111 7261 MNT 4.0 Workstation SPB German
3 Agent ‘Windows Solanisg Yes 20142121768 3178 SUN Solaris 8 workstation

The layout of this display is:

Field Description

Type Agent Group

Name A unique name, usually the | Any name which identifies
name of the host system, the agents, for example:
for example: BILBO. Windows Servers.

Platform The platform type. Thisis | Not used.

one of: AS400, Windows,
UNIX and OpenVMS.

This must be entered
correctly so that the
Controller is able to create
the correct script to change
the password on this
system.

Unlike SEM, the Controller
does not determine the
platform type in advance,
instead it relies on the
value in this field.

Address The name or IP address. Not used.
Port The port assigned to the Not used.
SEM agent, this is usually
7251.
Enabled Whether the entry is enabled.
Description A free-format description of the entry.
Members Not used. The members of the group.

For the very latest information see the online help for this display.

Starting

Select Agents, Display from the main menu.

42 e Controller Database Sysgem Password Synchronizer User Guide (Rev1l)



Add Agent Definition

From the Agents menu select Add Agent. Each agent definition is effectively a
description of where each SEM Agent is installed together with its address.

'i;] Add Agent ﬁ

Mame: * Bilbo [v]Enahle

Address:*  |201.4212.98

Fart: * 7261 Diefaultis 7251

Platform: WS B4
Description: |AYMS system

* = [nput required

| O | [ Cancel ]

Enter values in the fields:
e Name: The agent name — normally the hostname (recommended).
e Address: Either the name or IP address.
e Port: The port number assigned to the agent when installed.
o Platform: As appropriate.
e Enable: Check the box to enable the definition.
e  Description: Free-format text.
Then press OK.

Import Agent Definitions from SEM

From the Agents menu select Import. Agent definitions are imported one
platform at a time — the platform information is not available in the SEM
Management Console definitions so it must be added here.

It is easiest to export Agent definitions from the SEM Management Console to a
known file.

To export:
e  Start the SEM Management Console,
e  Select Agents from the Managers menu.
e From the Export menu select To File.

The file you create is a coded plain ASCII file from which the agent definitions
are loaded.

Location

The database DSN and location are shown in the Controller’s logfile window,
for example:

« Initializing

= @ Database
o DBM3
 DEN

- Driver
o File
o User

ACCESS

Sysgem Pwd Sync

odbcit3z.dll

C:\Documents and Settingsh\Simon\Application Datah\dysgem AGYPwdSynchSEMPwdSync
admin
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Select Agents

Agerts [Sadl Selected
Local AS400
bicrosoft AS400 Tester
bAr kdarvin

MT 4.0 5Fka

MT-4.0-English

MT-4.0-German

Motes Client

Motes Server

MNowell Client =

)= ‘m
Dffice

PwdSync Controller
FedHat

BodHatnan |
< ?

Flatform: -
Windows hdl

[ O ] l Cancel

Select:
e the definitions to be added,

o the platform assigned to the selected agent definitions (this is very
important),

then press OK.

Add Group Definition

From the Agents menu select Add Group. Each definition assigns one or more
agent definitions to a group, for example Development or Production.

-7 Add Group

Marme: * Development Enable

tMembers: ARG, Boris, Digital Unix, Gandalf. IEM D
Al FedHat Solarisd

Description; | Daily development systems

* = |nput required

| OK. | ’ Cancel l

Enter values in the fields:
e Name: The name of the group.
e Member(s): The members of the group.
e Enable: Check the box to enable the definition.
e  Description: Free-format text.
Then press OK.
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Rules Definitions

This display maintains the Rules Database, which defines what happens when a
password change request is received.

An example of a simple database with two rules:

% Rule Definitions Q@

Type Enable | From Except| To Options Comrment Timestamp
# Momal Yes wokk AS400:host* Bilbozhost*  MYS0L, ORACLE  Atestdefinition 4244-7BD7-01C5
# Mommal Yes wSysterm Gandalf: host* Atestdefinition  424A-TBES-0167

Each entry in the database consists of:

Field Description

Enable Whether the entry is enable (tick) or disabled (cross).

From The format of the from entry is hostname::platform::username
Except The format of the except entry is hostname::platform::username
To The format of the to entry is hostname::account-type::username

Options Options which correspond to functions in the Custom scripts, used for
third-party application support such as ORACLE.

Comment | A free-format description of the entry.

Timestamp | The creation date (for internal use by Sysgem).
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From (Password Change Request)
The format of a from entry is: hostname::platform::username, where:

e Hostname is the name of the host (agent), this does not have to be
defined by the Agents and Groups displays.

e Platform is one of AS400, Windows, UNIX and OpenVMS.

e Username identifies the account which has requested the password
change.

Note: you can use the * wildcard in any of these fields.
Except (Exception to From Entries)
The format of an except entry is: hostname::platform::username, where:

e Hostname is the name of the host (agent), this does not have to be
defined by the Agents and Groups displays.

e Platform is one of AS400, Windows, UNIX and OpenVMS.

e Username identifies the account which is not to have its password
changed.

Note: you can use the * wildcard in any of these fields. The username field
supports the * and % wildcards, where % matches a single character and *
matches any number or characters.

To (Password Change Target)
The format of a to entry is: hostname::account-type::username, where:

e Hostname is the name of the host (agent), and must already be
defined by the Agents and Groups displays.

e Account-type is one of host, SAP, Lotus Notes, ... (note: in the first
release only host accounts are supported).

e Username identifies the account which is to have its password
updated.

Options (Third-Party Application Support)

To enable support for applications such as ORACLE you add an option — a text
string such as ORACLE or MySQL — which corresponds to a function in the
Custom scripts.

For each option which you define there must be a corresponding Set_<option>
function in the Custom scripts, for example if the option is ORACLE then the
function is Set._ OPTION. For more information see the Custom scripts shipped
with the Controller.

Matching Rules

When a change request is received, the rules are read, analyzed in sequence (1,
2...) until one or matches are match made with rules which meet the criteria
below:

Sequence Hostname Platform Username
1 Exact Exact Exact

2 Exact * Exact

3 Exact Exact *

4 Exact * *

5 * * *

So if the first match is found at Sequence 3 then all rules at Sequence 3 which
match are used.
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An example of a rule’s From clause which matches Sequence 3 is:
BILBO::VMS::* .

This logic was changed on June 16™, 2005 so that many rules can be defined for
the same user(s).

Except Syntax

Pattern | Result

% Match exactly one character, % is replaced with \S.
* Match any characters, * is replaced with \S+.

[0-9] Match a single digit.

[a-Z] Match a lowercase letter.

[A-Z] Match an uppercase letter.

\d Matches a digit, same as [0-9]

\s Matches a whitespace character (space, tab...)
[1]2] Matches 1 or 2

+ Match the proceeding symbol one or more times.
Starting

Select Rules, Display from the main menu.

Add

From the Options menu select Add Agent. Each definition contains: Rule Type,
Enabled, Comment, From, Except, To, and Options fields.

Add Rule
Fule Type Frarm
(3 Marmal (O Blocker Host name: |Bilbg v Definitions
Platform * - AS4DD*_";"
[+| Enablad 4| Bilbo::
Usemams; |*
Add
Comment: Excapt
An example rule| Hostname: | ~ Definitions
Platfarm * v *.%:System

Usemame: |System

To

Hostname: |AZ400 ™ Dedfinitions

ACC. fype: host A AE4DD hast =
- EBilbo:host:*

Usemame: *

Add
Options
Option ORACLE Definitions
ORACLE

Add

{ Ok l l Cancel

General
e Rule type: Normal or Blocker.

e Enabled: Check to enable the definition.
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e  Comment: Free-format text.
From

Here you define one of more entries where each entry identifies an account (or
accounts if the * wildcard is used) which requests a password change.

Enter values in the fields:
e Host name: The host from which the password request is received.
o Platform: As appropriate.
e Username: Name of the account or the * wildcard.

Then press Add to add the entry to the Current Entries list. Repeat as necessary —
each rule can have one or more From entries.

Except

Here you define one of more entries where each entry identifies an account (or
accounts if the * wildcard is used) which is an exception to the definitions in the
From list.

Enter values in the fields:
e Host name: The host from which the password request is received.
e Platform: As appropriate.

e Username: Name of the account, this can contain the * (matches
any number of characters) or % (matches a single character)
wildcards.

Then press Add to add the entry to the Current Entries list. Repeat as necessary —
each rule can have one or more Except entries.

To
Enter values in the fields.
e Host name: The system where the password will be updated.

e Account type: Select either host, NIS or None. If set to None the
operating system account is not updated, only the accounts
associated with 3"-party applications are updated (see Options).

e Username: The account to be updated.

Enter an option then press Add to add the entry to the Current Entries list.
Repeat as necessary.

Options

For each option you add here there must be a corresponding Set_<Option> entry
in the Custom script for the Agent’s platform.

For example if the option is ORACLE then the function is Set._ OPTION. For
more information see the Custom scripts shipped with the Controller

When you have finished press OK.

Examples
Here are examples of rules definitions and the associated logic.
From Except To Options
PIPPIN::*::SMITH BILBO::host::SMI
_JOHN THJ
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John Smith's new password on PIPPIN is updated on BILBO where his account is
SMITHJ.

PIPPIN::*::SMITH BILBO::host::SMI | ORACLE
* TH*

All password changes for accounts starting with SMITH on system PIPPIN are sent to
BILBO, but the account name that will be updated is SMITH*. This is obviously
wrong — the To field contains a partial wildcard. The Rules Database display has now
been updated so that a partial wildcard cannot be entered in the To field.

The ORACLE account is also updated using the function Set. ORACLE in the Custom
script for BILBO’s platform.

PIPPIN::*::* | *.*..SYS* BILBO::host::* |

All accounts on PIPPIN except for accounts starting SYS (such as SYSTEM,
SYSTEST) are updated on BILBO.

VMS::*::SMITH_J UNIX::host::smith_

]
UNIX::host::j_smit
h

In this example John Smith has an account SMITH_J on a VMS system which must be
mapped through to two UNIX accounts: smith_j and j_smith. Because UNIX accounts
are case-sensitive (unlike VMS) the rule must explicitly specify the UNIX accounts, it
is not possible to use the * wildcard as this will result in an attempt being made to
update the UNIX account SMITH_J.

An alternative would be to modify the scripts supplied with this product to dynamically
update To account list.

If you need extensions to the Rules Database please contact your distributor or
Sysgem AG.
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Console

Overview

The console program is a standard DOS / command-line program for Windows,
UNIX and OpenVMS. It is used as an alternative to the interceptor.

The console program makes direct contact with the Controller when the

password is changed.

SEM Password Synchronization v2 build 2444

Sysgem AG Corporate Password Policy

Minimum chars:
Maximum chars:

At least 1 digit is required

You are logged in as:

0ld password: #####
New password: ########

SIMON-LAAX\Simon on BORIS

Retype new password: ########

Changed password for Simon
Connecting to 201.42.12.101

Reply: OK

Press Enter to continue

Configuration File

The console uses a configuration file which contains tokens and values:

Token

Value

LOCAL

Windows only: If set to No or Off or 0
then the local password is not changed.

NOTICE

Windows only: Text displayed when the
console program starts, for example you
can display your corporate password
policy.

ADDRESS

The address and port number of a
Controller.

The file is SEMPwdSync.cfg in the same folder as the console program, usually
this is C:\Program Files\Sysgem\SEM Pwd Sync.

Edit this file with Notepad or Wordpad.
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Example:
R R

#

# Sample configuration file for the SEM Password Synchronizer.
#

# Format of address entries is shown below.

#

# This file is used by the Console only.

#

#

# Change the local default (on by default)
#
LOCAL Yes
#

#

Banner
#
NOTICE Sysgem AG Password Policy
NOTICE Minimum password length is 8 characters
NOTICE Maximum password length is 14 characters
#
# Controllers
#
ADDRESS 201.42.12.101:7260
ADDRESS 201.42.12.102:7260

The console program tries all controllers in turn until one is found which is
available to service the change request.
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Windows Interceptor

Overview

The Windows interceptor consists of:

¢  SEMPwdWSync.dll in the Windows system directory, usually
\WINNT\System32.

This conforms to the Microsoft standard for a password filter DLL. It supports:

Function Description

InitializeChangeNotify | The function is implemented by the password filter DLL. It
returns TRUE or FALSE, indicating if the password filter
DLL is loaded.

PasswordChangeNotify | The function is implemented by the password filter. It is used
to notify the DLL that a password change was made.

PasswordFilter The function is implemented by the password filter DLL. It
returns TRUE or FALSE, indicating that the new password is
valid.

The DLL in enabled by updating the following registry key in the Windows NT
Registry. If Notification Packages exist, the name of the DLL is added to the
existing value (existing values may not be overwritten).

HKEY_LOCAL_MACHINE
\SYSTEM
\CurrentControlSet
\Control
\Lsa
\Notification Packages (add new value of type REG_MULTI_SZ)
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This is done when the interceptor is installed. After updating the registry the
system must be rebooted, this is a Windows requirement.

e Password notification and filtering only take place on the computer
that houses the updated account.

e Notification on domain accounts only takes place on the primary
Domain Controller for the Windows NT 4.0 domains. In addition
to the primary Domain Controller, the password filter packages
should be installed on all backup Domain Controllers to allow
notifications to continue in the event of server role changes.

e On Windows 2000 and higher, all Domain Controllers are
writeable, therefore the interceptor must be present on all Domain
Controllers.

e The interceptor functions run in the security context of the local
system account.

Logfile

The logfile is SEMPwdSyncLog.txt in the same directory as the DLL. The
easiest way to view the contents of the logfile is to use the Interceptor
Configuration utility.

Configuring

To assist with the configuration a small the Interceptor Configuration utility is
installed when you install the Windows interceptor.
This is started from the Start menu, the file is:

e  SEMPwdSyncConfig.exe in the Windows system directory, usually

\WINNT\System32.
= SEMPwdSyncConfig
Connection Definitions Instructions
Address Port Use this display to define the settings for the SEM |4
20142124 7760 Password Syncyhronization interception on this
systam.
Connection Definitions: you must add an address
and port number for at least one Windows system
where the SEM Password Synchronization
contraller is running. f ywou hawe rmore than one
contraller then add a definition for sach controllar.
Vactve Active: selectthis option if password
[¥llgnore accounts ending with $ synchronization is active on this system.
[ IPopup etror messages Ignore: select this option if accounts ending in §
. are to be ignored by the interceptor. These are
[Trece to logfile usually machine accounts and shares.
b verity password Popup: selectthis option if popup error
Mo last connection information availahle. messages are to be displayed by the interceptor.
Trace: selad) this option if extensive tracing is
written ta the logfile. The logfile is
SEMPwdSynclLog.td in the Swetem32 directony
To display the logfile press 'Lagfile’.
[ o]’ l ’ Apply ] ’ Cancel l Werify: selectthis option if the password istobe [,

The options are:

e  Connection Definitions: you must add an address and port number
for at least one Windows system where the SEM Password
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Synchronization controller is running. If you have more than one
controller then add a definition for each controller.

e Active: select this option if password synchronization is active on
this system.

e Ignore accounts ending with $: select this option if accounts ending
in $ are to be ignored by the interceptor. These are usually machine
accounts and shares.

e Popup error messages: select this option if popup error messages
are to be displayed by the interceptor.

e Trace to logfile: select this option if extensive tracing is written to
the logfile. The logfile is SEMPwdSyncLog.txt in the System32
directory. To display the logfile press 'Logfile".

o Verify password: select this option if the password is to be verified
by the controller. Use this option if you want to enforce a corporate
password policy.

Press 'OK' when you have finished making changes.
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OpenVMS Interceptor

Overview

The OpenVMS interceptor consists of:
e SEM-PWDSYNC-LOGINOUT.EXE in SYS$SYSTEM.

This has been written in accordance with the OpenVMS Utility Routines Manual,
LOGINOUT (LGI) Routines, (c) COMPAQ.

The OpenVMS kit is shipped as:

e vms_pwdsync_020_a.zip — VAX and AXP saveset (requires unzip),
or

e vms_pwdsync_020_axp.exe — AXP self-extracting executable,

e vms_pwdsync_020_vax.exe — VAX self-extracting executable.

Testing

When you connect to a remote system with the interceptor installed (for example
by using SET HOST) the string

|%SEM—I—PWDSYNCINIT, SEM Password Synchronizer initialized

is displayed. This confirms that SEM-PWDSYNC-LOGINOUT.EXE has been
started correctly by LOGINOUT.

Customizing

You can customize the text displayed during the phases of SEM-PWDSYNC-
LOGINOUT.EXE by using logical names defined in executive mode in the
system logical name table (define /system /executive).

Logical Name Phase

SEM _PWD_SYNC _IDENTIFY Callout identify
SEM_PWD_SYNC_AUTHENTICATE Callout authenticate
SEM_PWD_SYNC_FINISH Callout finish
SEM_PWD_SYNC_START Callout iact start
SEM_PWD_SET_PWD Setting password on local system

This is provided for diagnostic purposes by Sysgem.
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For example, to add extra text when starting:

$ define /system /exec SEM_PWD_SYNC_START_0 "Using Pwd Sync"
$ define /system /exec SEM_PWD_SYNC_START _1 "-------------- "

You can define up to 100 logical names (SEM_PWD_SYNC_START 0to
SEM_PWD_SYNC_START_99), gaps are not permitted.
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Examples

Introduction

These examples show the output you can expect when the program works
successfully and when you encounter errors.

Controller Not Found

In this example a LINUX Mandrake user (Walter) changes his password. The
configuration file contains three entries:

A
#

# Sample configuration file for the SEM Password Synchronizer.

#

# Format of address entries is shown below.

#

ADDRESS 201.42.12.104:7260

ADDRESS 201.42.12.105:7260

ADDRESS 201.42.12.103:7260

The Controller on 201.42.12.104 is not started, and 201.42.12.105 is currently
down for maintenance. Only 201.42.12.103 is available.

# /pwdsync
SEM Password Synchronization v2 build 1455
You are logged in as: Walter on Mandrake

New password:
Retype new password:

Connecting to 201.42.12.104
Error establishing connection with 201.42.12.104:7260, Connection refused

Connecting to 201.42.12.105
Error establishing connection with 201.42.12.105:7260, No route to host

Connecting to 201.42.12.103
Reply: OK
#

The sequence of connection attempts is:

1. 1P address 201.42.12.104 port 7260. This fails because the
Controller is not listening on port 7260, hence the error message
Connection refused.

2. IP address 201.42.12.105 port 7260. This fails because the host is
not available, hence the error message No route to host.
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3. IP address 201.42.12.103 port 7260. This succeeds — the change
request is sent.

Password Validation Error

In this example the password validation fails (password is too short).

# .Jpwdsync
SEM Password Synchronization v2 build 1455
You are logged in as: Simon on Mandrake

New password:
Retype new password:

Connecting to 201.42.12.104
Password error: Minimum length is 6 characters.
#

The user enters a new password of ABC (typed characters are not echoed on the
screen).

A connection is made with the first Controller in the configuration file, and the
new password is rejected.

The output in the Controller window is shown below:

Controller: Brief -1o] x|
H 21-0ct-2004 10:26:40: From Simon on BORIS... ;I

@ Error: Password rejected:
o Minimum length is 6 characters.
=88 21-0ct-2004 10:26:40: From Simon on BORIS

o Connection accepted from : 201.42.12.101
¢ 21-October-2004 10:26:40
e Validating password
® Minimum length is 6 characters.
Disconnection with : 201.42.12.101
M 21-Cctober-2004 10:26:40 -

KN M

To change the password validation criteria you must open the Controller's
Settings window, select the Scripts — Validation pane and edit the selected script.

For assistance please contact your distributor or Sysgem AG.

Rule Not Found

In this example a rule is not found for the supplied hostname / platform /
username.

# .Jpwdsync
SEM Password Synchronization v2 build 1455
You are logged in as: Simon on Mandrake

New password:
Retype new password:

Connecting to 201.42.12.104
Reply: OK

#
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The output in the Controller window is shown below:

Controller: Brief =] 3]
M 21-Oct-2004 10:28:58: From Simon on BORIS... ;l

=48 21-0ct-2004 10:28:58: From Simon on BORIS
o Connection accepted from : 201.42.12.101
M 21-0ctober-2004 10:28:58
o Validating password
e Validation disabled
M 21-0ctober-2004 10:28:58
e Password forward request from Simon on BORIS (Windows)
e Processing
e Processing>
® Rule not found for BORIS::Windows::Simon
e Distributing to 0 agent(s)
e Finished
e Disconnection with : 201.42.12.101
¢ 21-0October-2004 10:28:59 -

0 | H

The new password is validated, but the Controller fails to find a rule that
matches the account requesting the password change.

Target Agent Not Reachable

In this example the target agent Treebeard is not reachable.

# /pwdsync
SEM Password Synchronization v2 build 1455
You are logged in as: Simon on Mandrake

New password:
Retype new password:

Connecting to 201.42.12.104
Reply: OK
#

The output in the Controller window is shown below:

=lolx]
E Rgent 3/4: RedHat090 B
i) Platform ......: Linux {UNIX)
i) Nodename ......: redhat
i current dir ...: fopt/Sysgem/SEM
i) Current user ..: root
i) EBxecutable ....: ./ssm-commander
L Account sysgemtest found in fetc/passwd.
i) Username ......: sSysgemtest
i NIS ...........: false
i) Password set.
1 getting the DEMOAPP password for sysgemtest
i DEMCAPP: Mot yet supported

o

B Agent 4/4: Treebeard

@ Error establishing connection with 201.42.12.105:7251 - A connection
P,

e Finished

e Disconnection with : 201.42.12.101

¢ 21-October-2004 10:332:57 -

< | W

The Controller fails to connect to Treebeard because the computer is not part of
the network. The full error text is:

Error establishing connection with 201.42.12.105:7251 - A connection
attempt failed because the connected party did not properly respond after
a period of time, or established connection failed because connected
host has failed to respond.
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Target Account Not Found

In this example the target account in the matching rule does not exist on the
Windows server Gandalf.

The Controller connects to Gandalf, sends the script to change the password but

the script returns an error.

DEMORPPE: Not yet supported

4 |

=loix]
B Agent 2/5: Gandalf :I
i Platform ......: Windows NT 5.0 build 2195 Serwvice Pack 4
i Mame ..........: GANDALF
& current dir ...: g:\program files\sysgem-unicode\SEM Server\GANDALF Scripts Etc
i) Current user ..: SYSTEM
4 Username ......: Does Not Exist
@ Account Does Not Exist not found J
i) Rmpplication ...: DEMORPP
i Username ......: Does_Not_Exist
i) Password ......: #EESESEE
&Y
o

Target Account Updated

In this example the target account is updated successfully. Three target agents

are updated:

1. Agent1is Decus CH, an OpenVMS 7.3 system used by the Digital

User’s group in Switzerland. The account updated is Sysgem_Test.

2. Agent 2 is Gandalf, a Windows 2000 test domain controller. The
account updated is Sysgem_Test.

3. Agent 3 is RedHat090, a RedHat LINUX 9.0 workstation also used for
testing. The account updated is sysgemtest (RedHat does not willingly

support usernames which include punctuation).

The rule also updates the DEMOAPP account, as you see in the logfile the
custom scripts display the standard ‘Not yet supported’ text.

Controller: Brief

-lo| x|

f 21-0ct-2004 10:12:03:
B 21-0ct-2004 10:12:03:
- Connection accepted
M 21-Cctober-2004 10:
° Validating password
o Validation disabled
M 21-October-2004 10:
o Password forward re
° Processing
¢ Distributing to 2 a

Platform ......:
Name .......

Address
Current dir ...:
Current user ..:
SYSUAE .....
Username ...
Command
UAF-I-MDFYMSG, us

cebeeeeeees

DEMOAPE: Not wet

o

From Simon on BORIS... B
From Simon on BORIS

from : 201.42.12.101

1z:03

12:03
quest from Simon on BORIS (Windows)

gent (s)

B Agent 1/3: Decus CH

OpenvMs V7.3
ELIAS

: 63,1023

SYSSEYSROOT: [§YSGEM-55M-5VR]
[5YSTEM]

: BYSSSYSTEM: 3YSUAF .DAT

sysgem_test

: mer authorize modify sysgem test /password=XXEX¥E /MOPWDEXPIRED

er record(s) updated

getting the DEMORPP password for sysgem test

supported

| H 4
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B Agent 2/3: Gandalf
i Platform
Name
Current dir
Current user
Username

Full name
Comment
Flags
Last logon
Pwd expired
Password set.
Application
Username
Password
DEMOAFP :

Not vet

Platform
Nodename
Current dir
Current user
Executable

Username
NI
Password set.

DEMOAFPP: Not wet

cpEEEEEEEEEEBm - EEECEEEEEEEEEREE

e Finished
e Disconnection with

|

Controller: Brief

¢ 21-0October-2004 10:

Windows NT 5.0 build 2195 Service Pack 4

GANDALF

g:\program files)\sysgem-unicode\SEM Server\GANDALF Scripts Etc
SYSTEM

sysgem_ test

Account sysgem_ test found.

1 Sysgem Test

: Disabled

DEMOAEFP
sysgem_test
#HEHHE
supported

Agent 3/3: RedHat000

Linux (UNIX)
redhat
fopt/Sysgen/SEM
root
./ssm-commander

Account sysgemtest found in fetc/passwd.

sysgentest
false

Setting the DEMOAFFP password for sysgemtest

supported

201.4z2.12.101
1z:07
|
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OpenVMS Interceptor

In this example a user connects to 12.99 and logs on as GERARD:

$seth 12.99
%SEM-I-PWDSYNCINIT, SEM Password Synchronizer initialized

Go Away

Username: GERARD
Password:

Sysgem Enterprise Manager - Password Synchronization

Your password has expired; you must set a new password to log in

New password:

Verification:

%SEM-I-CONNECT, Connecting to 201.42.12.104 -
%SEM-I-VALDPWD, Validating password on 201.42.12.104 -
%SEM-I-REPLYOK, reply = OK

%SEM-1-UPDSUAF, updating local SYSUAF record -
%SEM-1-PWDOK, New password set OK

%SEM-I-CONNECT, Connecting to 201.42.12.104 -

%SEM-I-FWRDPWD, Forwarding password to 201.42.12.104 -
%SEM-I-REPLYOK, reply = OK

Good Morning!

42 failures since last successful login
$

First of all, the string

|%SEM-I-PWDSYNCINIT, SEM Password Synchronizer initialized

is displayed. This confirms that SEM-PWDSYNC-LOGINOUT.EXE has been
started correctly by LOGINOUT.

After the user has logged in using the GERARD account he is prompted for a
new password by SEM-PWDSYNC-LOGINOUT.EXE because the account's
password is detected as having expired.

Sysgem Enterprise Manager - Password Synchronization

Your password has expired; you must set a new password to log in

The new password is set and then sent to the Controller.

Full Logging

In general Full logging will only be used to detect errors in scripts or in the
configuration.

When full logging is enabled by selecting the Full option in the Controller menu
all scripts send and received are displayed in the logfile window.

This adds considerably to the size of the logfile and slows down the password
synchronization.
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M Controller: Full =1ox]

W Z21-0ct-2004 10:46:56: From Simon on BORIS. .. :J
B Full debug information being displayed
B (OMain Analysis:> DOS Commands
B [(QMain Analysis> PERL Script
[OMain Analysis> DOS Errors
B [(QMain Analysis> DOS Qutput
[OMain Analysis> PERL Errors
B [(QMain Analysis> PERL Cutput
e Agent: Gandalf> Connected to Z01.42.12_.103:3103
o Agent: Gandalf> Connection secured with SCSA
o Agent: Gandalf> Platform iz Windows Z000/NT (Server)
B [(QAgent: Gandalf> DO3 Script
B [(QAgent: Gandalf> Main Script
o Agent: Gandalf> Main Script executed
[ kgent: Gandalf> DOS Errors
@ [ Agent: Gandalf> DOS Cutput
[QAgent: Gandalf> Main Script Errors
B [ Agent: Gandalf> Main Script Cutput
o Agent: Gandalf> Disconnected
e Agent: RedHat0%0> Connected to 201.42.12.980:7251
o Agent: RedHat090> Connection secured with SCSA
o Agent: RedHat090> Platform is UNIX (LINUX)
B [(JAgent: RedHat090> Main Script
o Agent: RedHat090> Main Script executed
[dAkgent: RedHat0%0> DOS Errors
[dAgent: RedHat090> DOS output
[JAgent: RedHat090> Main Script Errors
® [(QAgent: RedHat090> Main Script output
o Agent: RedHat090> Disconnected
®m[21-0ct-2004 10:4A:56: From Simon on BORIS
K E— AW

There are two categories of script:

1. The Main Analysis which processing the incoming request, returning a

list of target agents and accounts to be updated, and

2. The target Agent scripts, in this example the agents Gandalf and
RedHat090 are updated.
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Message Flow

Console

A sample message flow where the console is used to change a password on a
Windows system is shown below.

The only difference between Windows and other platforms is that the old
password is validated using the controller as a normal Windows user does not
have sufficient Windows privileges / rights to do this.

For information about validating a password see the Microsoft knowledge base
article 180548 “How To Validate User Credentials on Microsoft Operating
Systems”.
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Old Password

When the user enters the old password is is validated by the controller as a
normal user will not have sufficient Windows privilege to do this.

Console: Old password (Windows)

Console Controller

User starts i X
Console For information about
validating a password see the

Microsoft knowledge base
article 180548 “How To
Validate User Credentials on

Microsoft Operating Systems”.

User enters old
password

Password sent
No
to controller

Password is
validated

Reply returned

to console

Accepted?

Yes

v

Prompt for new
password
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New Password

The new password is validated by the controller using the validation script.

Console: New password

Console Controller

User enters new v dt
es, send to
password controller Validation
enabled?
No
User confirms new
password Validate using
Validation script
Sendresult |
to console
No
Accepted? Validation is enabled from the
Controller using the Enable
Validation option in the Validation
page of the Settings (F8).
Yes
v Typical validation options are

minimum and maximum length,
minimum number of digits and / or
alphabetic characters.

Send password to
controller for
distribution
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Password Distribution

The controller distributes the password by preparing the script which is sent to
the agents where accounts are to be updated.

Controller: Password distribution

Controller

The computer name,
username and password are
sent to the controller

The script reads the rules database to
to determine the distribution list based

Run the main on the username and computer name.

analysis script The output is a series of scripts for
each agent where an account is to be
updated.

For each SEM Agent definition extract:

Parse output

[1] Platform
[2] Script
[3] 3 party options such as ORACLE

Begin ‘for each agent'...

Add the platform-
specific custom
code to the agent
script ([2] above)

Send to agent

Agent runs script

ﬁReturn outpth

Add output and
errors to logfile

End ‘for each agent’
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Interceptor

In this example a user in a Windows domain changes his password. The
interceptor is installed on the PDC, the Controller on a Windows system (this
could be the PDC, BDC or any workstation).

The logic flow is show below.

Step

Where

Description

1

Workstation

User changes password

2

PDC (or BDC)

The Password Filter routine in the interceptor is called.
(This routine can reject the new password.)

If password validation is enabled, a connection is
established with a Controller, and the password is sent
over for validation.

Windows Server

The Controller receives the request to validate the
password.

The script selected in the Scripts — Validation runs.

The script either accepts or rejects the proposed
password.

Windows Server

Assuming the password is not rejected, the password is
changed on the local system, then sent to the
Controller for propagation.

Windows Server

The Controller receives the hostname, username and
new password.

Windows Server

The script selected in the Scripts — Main runs, the
output is one script file for each agent where the new
password is to be applied.

Windows Server

A reply is sent back to the interceptor.

SEM Agents

The output scripts (above) run on each agent.
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Testing

Overview

Testing password synchronization is very straightforward. A simple Windows
installation can be used to ensure that you have correctly installed and
configured the software components.
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Change Log

2004

Date

Change

December 20, 2004 | Fixed problem defining the alternate folder for the controller

logfiles.
Enabled Windows XP Themes.
Re-worked the documentation.

2005

Date

Change

March 10, 2005

Fixed problem where the password was replaced with ##Ht###Ht if
Full was selected in the Password Synchronization Controller.

March 30, 2005

Added Agent and Rule definitions to the Controller interface, so it is
now no longer necessary to use the SEM PwdSync module to define
agents and rules.

e  The Controller service runs the DefineDatabase Perl script
to ensure the database has been defined and if already
exists is upgraded to the latest definition.

e  When the Controller user interface starts the Agents and
Rules windows are displayed.

e  For alist of options either right-click in the Agents or Rules
window or select options from the main menu.

June 16, 2005

The logic for matching rules has been enhanced.

In the Rules Definitions on page 45 the logic for finding the first
matching rule is explained. As of this release the first match is
returned together with all other matches with rules at the same level
in the table on page 46.

The result of this change is that you can now define as many rules for
the same From definition as you want. An example of a From
definition is *::*::System .

June 29, 2005

Minor cosmetic changes.

Logfile name synchronization between service and controller (user
interface) so that the controller knows the filename of the current
logfile in use by the service. Pressing the Refresh button or selecting
Refresh from the Logfile menu loads the current logfile and displays
it.

The script DefineDatabase.txt which creates the database definitions
has been tightened up to be doubly sure that existing databases are
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neither overwritten nor redefined.

December 13, Removed password from the logfiles when running with full
2005 debugging enabled.

Fixed Perl problem caused by installations of ORACLE 10g adding
the PERL5LIB environment variable.

2006

Date Change

February 14™, Upgraded controller toolbar icons.
2006

Date Change

September 1st", | Added a logfile menu entry to optionally switch to Full logging if an
2008 error is detected. Prior to this kit the logging mode was always Full if
an error was detected.
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